
 

 

Mobile Learning and Note 
Taking with Microsoft Office 
OneNote 2003 

How many times have you gone back to your notebook only to find you can’t read 
your notes very well, or the notes you took in class are incomplete and 
inaccurate? Have you taken research notes and then been unable to track down 
the source because you didn’t reference it properly? How long does it take to rifle 
through your notes to find what you need to study for an exam or to write a 
paper? How useful would more accurate notes be to you? How much time could 
you save if it were easier to find the right notes right away? How much more 
productive can you be when your notes are legible and comprehenisve? Microsoft 
Office OneNote 2003 is an exciting new product that enables you to capture the 
best of your in-the-moment ideas and turn them into valid, usable information in 
real time. OneNote complements other core programs within the Microsoft Office 
System by giving you a way to capture, store, organise, and manage your 
information in flexible and efficient new ways. 

In your classroom, for example, you can use OneNote to sketch out the new 
concept students might be having trouble grasping. You can project the chart 
onto a screen and use OneNote as a digital whiteboard for brainstorming 
sessions. If you’re in the school canteen, you can jot down a few reminder notes 
and then add them instantly to your Task list in Microsoft Office Outlook 2003. If 
you’re in the car or walking between classes, you can use the audio feature to 
record and store a quick note or two; and with a single click, you can link the 
audio to your typed or handwritten notes about a faculty meeting so that you can 
be sure you’ve got all the information stored together in one place, where you can 
easily access it later. Wherever you are and however you work, if you have good 
ideas, you can put those ideas to work as real information right away. 

If you do most of your note taking by typing on a laptop or desktop systems, you 
can keep OneNote open on top of other applications, so you can capture, save, 
format, print, search, e-mail, and share your notes easily without getting 
sidetracked from your current task. The power of the program is its flexibility—it 
works the way you do, encapsulating your thoughts in the way you’re most 
comfortable recording and applying them. 
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Why Is Improved Note-Taking Important? 

Visualise the notes for your last term paper or think about the last time someone 
handed you a list of phone messages. Research shows that most people have 
difficulty doing more than one thing at a time, even tasks as familiar as talking on 
a cell phone while driving. Note-taking—a process for understanding, 
summarising, and organising unfamiliar, complex, or difficult-to-remember 
material—can place considerable cognitive load on the brain when you’re also 
trying to accomplish another task. Case in point: most people know how difficult it 
is to participate actively in a meeting and take notes at the same time. 

Words to know: 
 
HTML-HyperText 
Markup Language—
Language used to format 
Web pages. 
 
Browser—A program that 
allows viewing of HTML 
formatted documents 
(Web pages). 
 
Digital Ink—the term for 
electronically produced 
lines and handwriting on 
a digital piece of paper. 
 
Handwriting 
Recognition—The 
method by which 
freeform text input by a 
stylus is converted to 
typed text in a computer 
system. 
 
Tablet PC—A computer 
with a superset of 
Windows XP that uses a 
pen as it’s primary input 
device through writing 
on the screen just as you 
would on a sheet of 
paper. 
 
Windows SharePoint 
Services—A collection of 
services that allow inline 
discussions, posting of 
documents and 
announcements, as well 
as contact and task 
management. It is fully 
integrated with the 
Microsoft Office family of 
applications. 
 
Microsoft® Internet 
Explorer 6.0—The latest 
version of Microsoft’s 
popular Web browser. It 
allows editing and 
displaying of Web pages, 
collaboration on 
standard Office 
documents through 
discussions, and Round-
tripping. 
 

According to a Microsoft survey, nearly 40 percent of employed adults reported 
that they wanted a more efficient way to take notes. According to Rob Newing in 
Management Week, a survey carried out by Microsoft Research found that 
91 percent of us regularly take down handwritten notes, but only 26 percent of 
us transfer them to digital format, and 23 percent often can’t find our notes in 
the first place (http://www.vnunet.com/Analysis/1138445). It follows that 
there’s room to make note-taking work better. Microsoft has developed software 
routines that electronically ease much of the drudgery of note-taking and 
automate tasks that were impossible to do manually. 

Why Is Improved Note-Taking Essential to Education 
Overall? 

Information is important to everyone, and using information effectively enhances 
productivity. OneNote can provide an excellent, easy-to-learn-and-use tool for 
capturing and sharing notes over wired and wireless connections. Specifically, 
everyone connected to an academic institution can benefit in a number of ways 
by using a flexible note-taking tool: 

• Teachers and faculty will be more productive—and perhaps more 
accurate—in their work. Transfer this benefit incrementally across 
hundreds or thousands of worldwide educators, and the result is a 
substantial gain in productivity. 

• Student/Educator and Educator/Administration Teams will be more 
productive when their members are connected together and better 
organised. 

• Communication among team members will be increased through shared 
notes. 

• Research and fact-gathering for team projects will be improved. 

• Flexible note-taking will enable individuals to gather information in the 
way they are most comfortable, which translates to better information. 

• Less duplication of effort will occur (i.e., taking notes by hand in a 
meeting or classroom and then typing them in a document afterward). 
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What specific factors should educators consider as they examine the benefits of 
integrating OneNote? The cost and risk factors both appear relatively low. 
OneNote is a modest-size application, and its installation is pain-free. Because 
OneNote is part of the Microsoft Office System, it gains the cost benefits of riding 
on the mature and strong security and ease-of-use features we are all familiar 
with. 

Why Is Improved Note-Taking Essential to Individual 
Teachers and Students 

Simply put, we have a lot of information to track. The volume of data is 
empowering and, at times, overwhelming. Most people would gladly pay a modest 
sum to save a couple of hours a week by not having to retype notes, look for lost 
pieces of information, or make up for someone else’s omission to carry out a 
crucial action item. 

Beyond daily personal productivity, today’s teachers pride themselves on 
personal development. The sobering truth is that in a rapidly globalising world 
economy, you must be not only good at teaching, but also be able to manage an 
increased load of administrative assessment and reporting. That means lifetime 
education is an ongoing personal responsibility for each of us…and note-taking is 
essential to learning. If there’s an edge to be had in any aspect of continuing 
education, you need it—and that’s what OneNote gives you. 

Finally, individual note-taking is about individual responsibility and personal 
accountability. A big part of Microsoft’s thinking in developing OneNote is to 
remove the barriers that prevent us from easily capturing information. As you’ll 
learn later in the chapter, Microsoft has provided features in OneNote that 
specifically help capture information and follow up on it. It’s about giving 
ourselves the tools that we need to remember our obligations, fulfill our 
responsibilities, and ensure that we do what we say we’ll do, when we say we’ll 
do it. OneNote can help make all of this possible. 

 How OneNote 2003 Can Help 

Software cannot (and should not) take notes for you, but Microsoft® Office 
OneNote 2003 can help you overcome some of the obstacles of meaningful note 
taking by providing the freedom and flexibility of paper with the efficiency and 
power of digital organisational tools. OneNote addresses traditional deficiencies 
by providing you the flexibility to take notes in the way you are most comfortable 
with, helping you organise your notes and search them for easy retrieval, 
accommodating multiple note types (i.e. typed text, drawings, audio, and 
handwriting), integrating with electronic research applications, and facilitating 
sharing and distribution of your notes. Good note taking skills are a necessity in a 
teaching and learning environment. The problem is, note-taking has historically 
been a frustrating exercise in futility as you struggle with the mechanics of the 
process. OneNote is here to change the face of information gathering for 
everyone by assisting in capturing the necessary data, organising it, and enabling 
access to the information in a meaningful way. So, sit back, toss aside your legal 
pad, pull out your PC and experience note taking in the 21st century. 
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In this workshop, you will learn how to use the features in Microsoft Office 
OneNote 2003 to assist you in the classroom, your office, your home and just 
about anywhere you need to collect information and organise it, making it 
available for future use. 

 Before You Begin 

Microsoft Office OneNote 2003 offers incredible flexibility in gathering, 
organising, and recalling information. This information may be typed text, sound, 
graphics, handwriting, or Web content. OneNote allows you to collect the data in 
a way that is meaningful to you and in a style that you are comfortable with. 
These notes can then be queried to find specific information; days, weeks, 
months, or even years later, eliminating the frustrating task of paging through 
traditional notes taken in a completely linear fashion. Sharing your notes with 
others can be as simple as sending an email or posting them up to a shared Web 
site and other students, teachers, and administrators wishing to view your notes 
are not required to have OneNote. A simple Web browser will suffice! All this can 
be accomplished on traditional PCs and laptops. If you happen to have a Tablet 
PC, handwriting recognition enables you to convert your handwritten notes into 
clear, legible text on the fly by standard extensions built into the Tablet PC 
operating system. However you use it, OneNote 2003 will change the way you 
take notes in a remarkably positive way. 

Setup and requirements for this lab are listed below.  

Requirements:  

• Microsoft OneNote 2003 loaded on the workstation 

• Internet access 

• Student notebook present in My Notebooks folder 

 
To obtain the student notebook, download Onenote edlab.zip and unzip the 
archive (found in the tutorials folder of this CD) into My Notebooks which is 
under My Documents. Please remember this location may be unique for each 
login on individual workstations. 
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  Touring OneNote 

Before you start using OneNote 2003, become familiar with its features. The 
following illustration shows a new blank note in Page view:  

 

Familiarising yourself with OneNote 

If you’ve ever used a Microsoft Office application such as Word or Excel, you’ll 
notice that OneNote looks very familiar. A toolbar runs along the top of the screen 
with many of the same functions you are used to seeing, such as text formatting, 
bullets, and cutting and pasting tools. OneNote is set up like a spiral bound 
notebook with tabs across the top and note pages (and sub pages) down the 
side. Each tab along the top is a different section which can be organised by 
project, class or subject matter. The tabs that go down the side represent 
different pages within the section you have chosen. The My Notebook drop down 
to the left of the sections, allows you to switch between different notebooks, just 
like reaching into your book bag or briefcase and pulling out a different binder. 

We will more fully investigate using OneNote by walking through an example 
scenario in an educational setting. You will be playing the part of teacher and 
student and seeing how improved note taking and organisation can positively 
impact learning outcomes.  

Sections 

Note Body

Note Handle 

Menu Bar

Title Pane 

Active Page 

Toolbars

Window Sizing 
Buttons 

Page Tab 

Sub Note 
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Research and Note Taking 

For the purposes of this section of the workshop, imagine that you are a student 
in a geography class that is involved in a research project involving earthquakes. 
This section will walk you through some very basic ways you can use OneNote to 
help you complete the requirements of your class. 

As you become more familiar with OneNote, the benefits of extending note taking 
into the digital realm will become evident.  Unlike note-taking in a paper-based 
world, for example, with OneNote you can take not only typed or handwritten 
notes, but you can also record audio notes directly into your notebook. A student 
can record the instructor during a lecture or record an interview as a research 
source and transcribe notes from the audio later at a more relaxed pace. Or if 
you’re more visually oriented, you may choose to incorporate drawings that 
communicate the same information. With OneNote, a page of notes can include 
any combination of text, drawings, and audio – all of which are organised and 
searchable making data easy to retrieve at a later time.  

If you have a Tablet PC, you can write and draw with digital ink just as you do in 
Tablet PC applications like Windows Journal. Handwriting recognition is available, 
but entirely optional, and you might choose to keep your notes in ink format, just 
like paper notes that you simply refer to and don’t bother to retype. Since the 
search functionality and other features of OneNote work equally well with text or 
ink, there’s no need to convert everything you write to text. It’s not the kind of 
handwriting recognition that you have to train. The basic guideline is that you use 
digital ink just like you use regular ink. If you use handwriting in your paper notes, 
you’ll probably use handwriting in your digital notes. 

To open a notebook 

1. On the Start menu, point to All Programs, click Microsoft Office, 
and click Microsoft Office OneNote2003. OneNote opens the 
notebook (if any) that was open the last time the application was 
running. 

2. On the File menu select Open and the File Open dialog box will 
appear. 
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3. Double click on the Student folder and then double click on 
Earthquakes. The Student notebook will open with the Earthquakes 
section displayed.  

 
Subpages are great for 
any activity that has 
common information 
that is repeated a 
number of times. 
Experiments in a lab, 
opinion interviews for 
gathering research 
data, and recording 
evaluations on multiple 
individuals are a few 
examples. Just enter 
the common questions 
or information in the 
title area and enter the 
unique notes for each 
entry on sub pages. 
 

 

Additional notebooks may be opened in similar fashion or by selecting a 
section in a particular notebook from the Notebooks drop down to the 
left of the section tabs. (Your dropdown will currently read “Student”, 
reflecting the notebook that is currently open in OneNote). 

To insert a page or subpage 

1. Click Insert from the menu bar and then click New Page from the 
list. 
-or- 
Click the New Page button at the bottom of the page tabs to the 
right of the displayed page. 
-or- 
Right click on an existing page tab and select New Page 
A new page will be created and opened within the current section. 

2. Click Insert from the menu bar and then click New Subpage from 
the list.  
-or- 
Right click on an existing page tab and select New Subpage 
A new subpage will be created under the current page. 

For both pages and subpages, it is important to select the container 
where you would like the new item to be placed. While a new item in the 
wrong place can be moved very easily, placing it in the proper repository 
in the first place will save time. 
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Taking notes 

1. Select the Earthquakes Research Topic page tab from the tabs on 
the right of the active page to navigate to that page. 

 
 
Creating an outline in 
OneNote is the same 
process as creating 
one in Word. Just 
select the notes that 
you wish to be part of 
the outline and then 
select the Numbered 
List from the toolbar. 
(Make sure all the 
notes are part of the 
same note block) Any 
changes in hierarchy 
may be accomplished 
by increasing or 
decreasing the indents 
for each line. 
 

2. Click anywhere on the page and type your note. For the lab, type 
“Largest earthquake in 20th C. in Chile.” 

3. Move your cursor over your newly created note and a control box will 
pop up to the left of the block.  

 

4. Click on the box. While holding your mouse button down, drag the 
note around the page. This is one of the ways to organise your notes 
after you collect them. 

5. Grab the “Extra credit ‘How does the Richter scale work’” line and 
drop it on the bottom of the note block titled “Things we need to find 
out.”  
By grouping similar notes together on the fly, you can create order 
out of chaos. 

6. Moving your cursor over a note block displays a gray bar at the top 
of the block. Click on this bar to move the entire block of notes, thus 
allowing you to organise entire groups of ideas further adding to the 
ease of retrieval of information from your notes. 
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7. If you need more space within a given block, just click on the block 
handle (gray bar) and drag out the right side to expand it. (This is 
just like sizing any other object in other Microsoft Office System 
applications, except you can only increase the horizontal distance.) 

In addition to simply moving your notes around the page, you can use 
indents to arrange a hierarchy to notes that have been grouped together. 
This serves to further organise your information which facilitates 
referencing the collected data in the future. 

8. Click anywhere on the note “Geological effects” in the Extra Credit 

group. Click on the Increase Indent button  on the tool bar to 
indent the line one level 
-or- 
Press the Tab button on your keyboard. 
(This works exactly like the indention tools in Microsoft Word). 

Drawing and writing notes 

One of your team members had discovered some interesting information 
on subduction zones that you wish to preserve. Knowing that a picture 
would be a much better method of recording this very graphical 
information you draw a diagram to represent this topic. 

1. Click below the note you just created and type “Subduction Zones:” 

2. On the Tools menu, click Drawing and Writing Tools. Select Pens 
and then choose the appropriate pen for the task 
-or- 
Select the Pen button dropdown from the tool bar and select the 
appropriate pen. 

 

3. Select the Green Highlighter and highlight the words you just typed 
in step one. 
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4. On the Tools menu, click Drawing and Writing Tools. Select Pens 
and then choose the Black Thin Felt Tip Pen. 
-or- 
Select the Pen button dropdown from the tool bar and select the 
appropriate pen 

 

5. Roughly draw to the best of your ability, the picture in the 
screenshot. Remember if you make a mistake you may either click 
the Undo button on the toolbar or use the Eraser tool (also on the 
toolbar) to remove the desired ink. Just click and hold the left mouse 
button down as you drag the eraser over the lines you wish to delete. 
Everything the eraser touches while you are holding the left button 
down will be erased. 

Note: This is only one of a myriad uses for drawing objects in your notes. 
The drawing feature can be used for drawing pictures, equations, and 
charts or for adding additional formatting to your notes for emphasis. 
Remember, drawings can float on top of the other items in your note 
page enabling you to capture a page from a Web site and mark it up. 
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Conducting Research 

1. From the View menu, select Task Pane to display the task pane 
which will appear on the right side of your screen. 

2. From the drop down menu at the top of the pane select Research. 
The research pane will now be visible. 

Note: Whatever note you are on becomes the default text to search for in 
the research pane. You must be connected to the Internet for this 
section. 

3. Type in “earthquakes” in the Search for: box. 

 

 
 
The research pane is 
available across 
Microsoft Office 
System applications 
and will display unique 
searches for each 
document open in an 
application. Regardless 
of where you open your 
research from, 
SideNote will serve as 
the collection tool for 
the data. 
 

4. Click on the drop down menu for All Reference Books to specify the 
areas that you would like to conduct your search. The drop down is 
directly under the search string box towards the top of the pane. 

5. Select Encarta Encyclopedia as the resource you want to search. 
Once the selection has been made, the search will automatically 
occur. 

6. Select Article Encarta Encyclopedia and your web browser will 
launch and display the article. Maximise your Web browser. 

7. Click on “17 items under Multimedia” right under the picture at the 
top of the article to navigate to the multimedia objects. If you cannot 
access this site, any relevant topic will suffice here. 

8. Click on the “Locating Epicenters” item (4th from the left on the top 
row) 
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9. Select the picture and text by clicking at the end of the last sentence 
of text and dragging it up above the top of the picture. 

Traditional research would involve copying and pasting, while flipping 
back and forth between several applications. We however will gather 
research notes more efficiently with the SideNote feature in OneNote. 
This useful tool opens a small version of OneNote that floats on top of 
your browser window so that you can easily drag content from your 
browser into your SideNote to collect your research notes. With 
SideNote, you don’t have to switch from one window to another, or use 
multiple applications. 

Launch SideNote by clicking on the OneNote icon in the system task 
tray. (The set of small icons in the lower right corner of your screen.) 

10. If the pushpin icon on the toolbar at the bottom of the SideNote 
screen is not orange (selected), click the button to make SideNote 
float over top of the browser window. 

 

 
 
Maximising the 
SideNote window will 
show you that 
SideNote is just a 
section of your 
existing notebook and 
can therefore be 
searched, organised, 
and edited as any 
other OneNote 
section. 
 11. Click and drag the selected text and picture from your Web browser 

into SideNote and release. The items are now in SideNote and the 
source URL is included for reference.  

The information needs to be placed in the proper page and section in 
OneNote. Right now it exists in a page called Side Notes in your main 
notebook. 

12. Click on the OneNote button on your task bar to switch back to your 
notes. 

13. Drag the text and picture to the My research topic page and arrange 
the content as you see fit. Remember to drag the entire group by 
using the gray bar at the top of the block. 
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Using audio recordings 

As part of the research effort, you are conducting an interview with a 
subject matter expert on earthquakes from the US Geological Survey. 
Rather than disturb the flow of the interview, you choose to record the 
proceedings and take notes from the recording when the interview is 
complete. Recording information given by an instructor during a lecture 
or taking the minutes of a project meeting would benefit greatly from 
audio recordings as well. 

1. Click on the My research topics tab to navigate to the page 
containing your notes for the research project. 

2. Click in a blank area of the page and type “Interview with Rob Craig 
– USGS.” 

3. On the toolbar, click the Start/Stop Recording  button and 
start speaking to begin the interview. The recording toolbar will 
automatically appear displaying standard control buttons for play, 
stop, pause, and record, similar to the buttons on a VCR. 

 

4. Type very brief topical notes as the interview progresses. 

5. Click the Stop button (square) on the Audio Recording toolbar to 
terminate recording at the end of the interview. 

6. Move your cursor over text denoting the portion of the interview you 
wish to review and notice the speaker icon that appears on the left.  

 
This is indicative of an audio recording. OneNote synchronises the 
text you typed during the interview with the recording. Recording in 
this manner will result in a karaoke style playback of audio and text. 
OneNote will highlight the notes that coincide with particular points 
in the recording; further adding to the value of the note-taking 
process. Click on the speaker to play the audio. 
-or- 
Click the Play button on the Audio Recording toolbar to hear your 
recorded audio. 

 
 
Audio recordings are 
created in Windows Media 
Audio (.wma) format and are 
therefore useful even 
outside the OneNote 
interface. 
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Note: You must have a microphone to record audio and speakers or 
headphones to play back the recorded audio. Most laptops and Tablet 
PCs have these features built in to the unit. If you do not hear any sound 
upon playback you may wish to check the output volume on your 
speakers. Be careful not to turn up the speaker volume too high or you 
will get a loud squeal indicating that feedback between the microphone 
and speaker is occurring. 

Using Digital Ink on a Tablet PC 

The Tablet PC incorporates a version of Windows XP that includes 
special pen-based functionality. You must have a Table PC to complete 
this section. 

1. Click on the Tablet PC section tab with your stylus to switch to that 
section. 

 
 
Handwriting recognition 
is one of the most 
powerful options 
available only on the 
Tablet PC. You may 
choose to have the 
tablet recognise your 
handwriting on the fly or 
leave the text as is. 
Either way, your notes 
are searchable and you 
may choose at any time 
to convert your 
handwriting to text. 
 

2. Observe the annotation of the Web content that was copied to this 
page. The handwriting can be converted to text or left as a graphical 
object 

3. Right click on the handwriting “Just like mine” and select Convert 
Handwriting to Text. Handwriting may be print or cursive text and 
the recognition system does not need to be trained. 

Handwritten text does not need to be converted to typed text to be 
searchable. OneNote on the Tablet PC performs an on the fly recognition 
while executing the search. This allows you a myriad of input options, but 
still allows very powerful retrieval functions. 
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4. Type Benefits in the search box and press Enter. Not only is the 
typed text found, but the handwritten word benefits is also 
highlighted indicating that it was found as a match during the 
search.  

Just imagine the benefits of using this type of functionality in your daily 
activities. OneNote is a very useful tool on a regular PC, but it gains 
greater portability and functionality with the Tablet PC. If you would like 
to learn more about the Tablet PC just point your browser to 
http://www.microsoft.com/tabletpc. 

Organising and Searching 

You have already witnessed the ease with which you can take notes within 
OneNote. The next step is to make these notes useful by organising them to 
facilitate quick and easy retrieval of the data in the future. The exercises you 
have done thus far have exposed you to limited organisation via dragging 
and dropping, but the true power of OneNote has yet to be revealed. In this 
section you will experience organisation and retrieval offered through note 
flags and a sophisticated search engine. 

Using note flags 

Note flags allow you to mark your notes for simplified retrieval at a later 
date. Many of you may use stars, dots, boxes, or exclamation points to 
mark key information in your paper notes. Note flags bring this same 
functionality into the digital realm but with the added benefit of tools to 
sort and retrieve flagged items that paper simply is unable to match. The 
built-in note flags are Question, Important, and To-Do. Custom flags may 
be created to augment this list. For example, an “On Test” flag might be 
appropriate for students wishing to quickly navigate to notes that will 
assist them in studying for a test. Flagged notes may be viewed in a 
summary by viewing the Note Flag Summary Pane. This displays the 
entire list of flagged notes based on the scope you tell it to use. Flagged 
items in the list may be retrieved by clicking on the flag in the summary 
which displays the corresponding note.  

1. Click on the Earthquake research topics page tab to switch back to 
your original page. 

2. Select and right click on “Extra Credit”, click on Note Flags and 
select the To Do (checkbox) flag.  
-or- 
From the View menu select Toolbars, then Note Flags. Click on the 
sentence you want to flag and click the desired flag on the Note Flag 
toolbar. 

Opening the toolbar first will save a lot of time if you are flagging a 
number of notes. 

3. From the View menu select Notes Flag Summary to display the 
Summary Pane. 
-or- 

Select Notes Flag Summary from the Toolbar drop down 
menu. 
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4. Change the scope of the summary by selecting My entire notebook 
from the Search: dropdown menu. The list of flagged notes 
increases as the change you just made told it to look in your entire 
student notebook not just the section on earthquakes as it had 
earlier. 

In addition to customising the Note Flag Summary by changing its scope, 
you may group the summary by Note Flag Name, Section, Title, Date, or 
Note Text. Through these different groups you have a flexible set of 
options to view and retrieve your important notes. 

5. Click on the link to the Born note at the top of the Important flagged 
notes and you will navigate to the English section of your notebook 
to the page containing that note. 

Customising note flags 

1. Select Customise My Note Flags from the Task Pane drop down 
menu. 

2. Select the first undefined flag and click the Modify button at the 
bottom of the list of flags. The Modify Note Flag dialog box will 
display.  

 

3. This flag will be used to mark anything that will be on a test to assist 
you in studying. Type “On Test” in the Display Name box. 

4. Select the symbol from the dropdown list and corresponding text 
and highlight color if you desire. Ideally the symbol should be unique 
from the ones that are currently in use to assist you in differentiating 
various flags on a given notebook page. 
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Searching through notes 

Another important issue in the reclamation of useful information within a 
note taking system that contains voluminous numbers of entries 
depends on a robust search facility. Ease and flexibility in searching are 
a welcome part of OneNote and the real beauty of the search facility is 
no action on the part of the note-taker is required to make the search 
functional and speedy. In fact, the scope of your search can be narrowed 
to increase the speed of the search and limit the number of hits in 
regard to your search criteria 

1. Click in the Search Box, type “earthquake” and press Enter. The 
search box is directly above the page tabs on the right side of your 
screen. 

 

 
 
You can change the 
order that your 
search is arranged 
by selecting the 
desired order from 
the Sort by drop 
down in the Page 
List pane. 

2. The search results are sorted by section by default. You may click on 
a link to navigate to the note returned by the search. You may also 
change the scope of the search by selecting the appropriate item 
from the Search box. 

3. Click on the Earthquakes section tab. Each page that contains an 
occurrence of the results is highlighted in yellow. You may also 
navigate through the results in a linear fashion by clicking on the left 
and right arrows on the yellow navigation bar at the top of the 
notebook pane.  

Navigating through the results in this manner would be like flipping 
through the pages of your old spiral bound notebook, but all pages that 
do not pertain to what you are looking for would be hidden. The process 
of looking through a series of pages is called rifling and is largely a very 
inefficient way to search for something and it leaves quite a mess. Never 
lose a page of notes again and be able to find any given note with speed 
by keeping notes the digital way. You’ve taken the time to take careful 
notes and OneNote leverages that time by making it easy to find specific 
notes without requiring you to remember where they are. 
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Sharing and Collaboration 

For students and instructors operating in the academic community, collaboration 
and sharing of information is key to the learning process and especially important 
in any team or group effort. Research, curriculum development, and policy teams 
all require input from a group of individuals to ensure the best results are 
achieved by drawing on the relative strengths of the members of the group. 
Collaboration is the norm and not the exception in the workforce and studies 
have consistently showed its value in education. OneNote has some great 
features that encourage sharing of information by making it simple and 
effortless.  

In this section you will share information with your colleagues through OneNote’s 
email integration with Outlook 2003. You will assign project tasks based on 
action items occurring in your notes and you will provide a persistent shared 
workspace with OneNote’s integration with services like Windows SharePoint 
Services and MSN. These shared workspaces are the cornerstone of 
collaboration and are fully supported by the entire Microsoft Office System suite 
of applications. 

Assigning tasks 

During a project meeting you need to assign tasks based on the 
information gathered thus far in the project. Since you have Outlook 
2003 you can easily assign a task to a fellow team member to find more 
information on tsunamis. You could also delegate action items and 
assign tasks regarding curriculum development resulting from notes 
taken at a faculty meeting. 

1. Click on the Earthquake research topics note page at the top of the 
page list. 

2. Select the text “Where does relief funding come from” under the 
extra credit note block and click the Create Outlook Task button 

 on the toolbar. A new task will be displayed with the selected 
text as the Subject and the text of the note in the body.  

 
If you have an Exchange 
Server, you may have 
Outlook keep you up to date 
regarding the progress of 
tasks you have assigned to 
others. In larger projects, 
like moving the library into a 
new media center, Microsoft 
Project may be used in 
conjunction with assigned 
tasks to produce progress 
charts and reports from task 
information stored in each 
individual’s task list. 
 

3. Just fill out the rest of the task information and click Save and Close 
to add this task to your personal task list. You might choose to 
assign this task to someone else on your research team, at which 
point you will need to fill out the task assignment options. (See 
figure on next page) 
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Sharing Notes via Email 

As team leader it is your job to distribute the work of this project. An 
outline of the subject matter needs to be generated as you begin to pull 
the project together at the end of the research phase. You decide to 
email the research topics page to a team member for completion of this 
task.  

1. Click on the page tab for My research topics to switch to that page if you 
are not already there. 

2. On the File menu, click Email. This will open a new message in Outlook 
2003 with the OneNote file attached. If the recipient has OneNote, the 
page will automatically be added to their notebook when they open the 
attachment, which makes sharing your notes effortless. 
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With Outlook 2003, your notes appear in the body of the email in HTML so 
that your colleague can read your notes even if they do not use OneNote. 
Outlook 2003 enables emailing of notes with a single click, but users of 
previous versions of Outlook must manually attach the .one file to send it 
and no HTML conversion takes place, requiring the recipient to have 
OneNote to view the attached notes. By emailing notes with Outlook 2003 
you may share your notes with virtually anyone as the person isn’t required to 
have OneNote.  

3. Address the email and click Send. 
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Publishing notes as web pages 

 
 
Windows SharePoint 
Services is a set of 
services that run on a 
Windows 2003 server 
that make up the base 
for a collaborative Web 
site. The site offers 
shared document 
workspaces, links, 
contacts, discussions, 
and announcements. If 
you would like to learn 
more about SharePoint 
review the tutorial 
entitled Developing 
Collaborative Courses 
Using the Microsoft 
Office System 
 

Your fellow students need persistent access to your notes for the 
collaborative project you are working on. Posting your documents to a 
shared location will satisfy this need. This might be a network drive, a 
web server, or a server that has been extended with Windows SharePoint 
Services or MSN. By placing notes in a central repository, peers may 
access the notes without requiring interaction with the originator of the 
notes. Security built in to Windows SharePoint Services will protect your 
notes and other documents to prevent any unauthorised access or 
editing. Participants in the collaborative work may use Internet explorer 
5.5 or later or the latest version of Netscape Navigator. 

1. On the File menu, click Publish Pages. The Publish window will be 
displayed. 

2. Navigate to the location that you wish to publish the pages to. For 
the purposes of this tutorial, click on Desktop and click the Publish 
button. 

 

The page will be saved and you may double click on the file on the desktop to 
view your handiwork. 
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 Getting Help 

You can get help from the Help menu at any time while you are using OneNote. 
To open Help, click Microsoft Office OneNote Help on the Help menu. If you 
have an Internet connection, you can also point to Microsoft Office Online on the 
Help menu and choose from several resources that may be of interest to you 
such as Product News, Frequently Asked Questions, and Online Support. You 
can also go to http://www.microsoft.com/onenote for all the latest information. If 
you are just getting started, a built in tutorial is available from the Help menu by 
selecting Get Going with OneNote. 
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